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第一章 SP3S400 ボードの概要 

Xilinx 社最先端の 90nm プロセスを使用した Spartan ソリューションである Spartan-3 

FPGA プラットフォーム、40 万システムゲートの XC3S400 マイコンを採用しております。

本ボードの主な特徴： 

１、Xilinx 開発プラットフォーム、MicroBlaze ソフトプロセッサを使用することもで

きます。 

２、480Mbps のハイスピードの USB2.0 データインタフェースも提供しております。 

３、多機能のインタフェース、拡張インタフェースを提供しております。 

Xilinx FPGA のスタートキット、設計研究キットとしてお勧めです。 

 

1.1 仕様概要 

 

JTAG 
7SEG LED 

電源 SW 

拡張アドレス I/F 

電源 

VGA 

ブザー 

PS2 

PS2 

ユーザーLEDｘ８
XCF02S 

XC3S400 

SDRAM 

SRAM 
FLASH 

RS232 

リセットキー 

LCD I/F 
ユーザキー 

SW キー 
赤外線 I/F 

3 線 RS232 
USB2.0 

拡張ユーザ I/F 

拡張データ I/F 

CY7C68013 

1、Xilinx Spartan3 シリーズ XC3S400 

下記五つのモジュールで構成されています：CLB（コンフィギュラブル ロジック ブロック）、

IOB（SelectIO）、BlockRAM、Multiplier（乗算器）、DCM（デジタル クロック マネジメン

ト）。 

（1） CLB：RAM 基づいた LUT を含めて、ロジックとメモリを実現する。一つの CLB で４つ

の連動の Slice を含めている。 
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（2） IOB：外部 I/O ポートとデバイス内部ロジック間のデータフローを制御する。三つの

信号通路がある：インプット通路、アウトプット通路、トライステート通路。 

（3） BlockRAM：完全デュアル ポートの 18Kb ブロック RAM 

（4） Multiplier：二つの 18 ビットのバイナリデータを入力可、16 ビットの結果を計算

して出力する。 

（5） DCM：遅延ロックループ、デジタル周波数合成、位相シフト、ステータスロジ ック、

四つの機能がある。 

本ボード採用しているマイコン XC3S400 は PQ208 パッケージで、デバイス特性は下記： 

System Gates：   400K 

Equivalent Logic Cells： 8,064 

Distributed RAM Bits:  56K 

Block RAM Bits:   288K 

Dedicated Multipliers:  16 

DCMs:    4 

Maximum User I/Os:  141 

2、XCF02S、コンフィグデバイス、PROM モードのダウンロード、JTAG モードもサポートす

る。 

3、512KB 高速 SRAM、256K x 16Bit 

4、8MB 高速 SDRAM、4M x 16Bit、最高 166MHz のスピード 

5、2MB FLASH、2M×8Bit、アクセススピードは 90ns 

6、RS-232 シリアルポート、DB9 メス 

7、VGA インターフェース、512 色 

8、7SegLEDｘ４、ユーザ LEDｘ８ 

9、1602 LCD 液晶インタフェース 

10、PS/2 インターフェース、3.3v と 5v のデバイスをサポートする。 

11、USB2.0 高速データインタフェース、CY68013 で実装している 

12、ユーザシリアルインタフェース 

13、拡張インタフェース、Video、AUSB_Dio、Wireless などの実現 

 

1.2 外形寸法 

153×106(mm) ※突起物は除く 

 

1.3 商品内容 

1、SP3S400 開発ボード 

2、LPT ダウンロードケーブル 

3、1602LCD 液晶モジュール 
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4、5V/1A 電源 

5、シリアルケーブル 

6、USB ケーブル 
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第二章 ハードウェア仕様 

2.1 SWキー 

二つの SW キーを提供している（SW7）。 

回路図： 

 

ピンマップ： 

 

ON の位置にすると、PB 信号は Low になる。 

 

2.2 ユーザーキー 

四つのユーザーキーを提供している（SW3～SW6）。 

回路図： 

 

ピンマップ： 
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2.3 ユーザーLED 

８つのユーザーLED を提供している（LED1～LED8）。 

回路図： 

 

ピンマップ： 

 

 

2.4 7SegLED 

4 つの 7SegLED を提供している。 

回路図： 
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ピンマップ： 

 

 

2.5 ブザー 

一つのブザーを提供している。クロックの周波数の変更で各種の音楽を生成できる。 

回路図： 

 

ピンマップ： 
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2.6 VGAインタフェース 

 

回路図： 

 

制御信号：VD1(Red_L), VD2 (Red_M), VD3(Red_H), VD4(Green_L), VD5(Green_M), 

VD6(Green_H), VD7(Blue_L), VD8(Blue_M), VD9(Blue_H), VGA_HS(Horizontal Sync), 

VGA_VS(Vertical Sync)。 

各色の線は、高、中、低の制御線があって、100、300、１Kの抵抗を接続してFPGAのIOと繋

がっている。VGAインタフェースは赤、緑、青三色線があるので、９つの制御線がある。論

理的に29=512色が表示できる。 

VGA_HSとVGA_VS信号はTTLレベルでVGAの水平と縦のスキャン信号を制御する。 
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ピンマップ： 

 

 

2.7 PS/2 インタフェース 

PS/2 DINインタフェース： 

 
回路図： 
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ピンマップ： 

Signal  FPGA Pin 

PS2DK   Pin 12 

PS2CK   Pin 13 

PS2DM   Pin 10 

PS2CM   Pin 11 

 

2.8 RS232 シリアルポートインタフェース 

二つのRS232インタフェースを提供している（DB9と3Pin拡張ピン）。同時に送信、受信でき

る。 

DB9インタフェース図： 

 
回路図： 

 
ピンマップ： 

Device  Signal   FPGA Pin 

U1   UART_TX   Pin 18 

U1   UART_RX   Pin 16 

U1   UART_TX_EXT   Pin 20 

U1   UART_RX_EXT   Pin 19 
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データ転送時、対応しているLEDが点灯する。 

 

2.9 LCD液晶インタフェース 

回路図： 

 

ピンマップ： 

Device  Signal   FPGA Pin 

JP9-4   LCD_RS    Pin 93 

JP9-5   LCD_RW    Pin 90 

JP9-6   LCD_E    Pin 87 

JP9-7   LCD0    Pin 22 

JP9-8   LCD1    Pin 24 

JP9-9   LCD2    Pin 26 

JP9-10   LCD3    Pin 27 

JP9-11   LCD4    Pin 28 

JP9-12   LCD5    Pin 29 

JP9-13   LCD6    Pin 31 

JP9-14   LCD7    Pin 33 

説明： 

Pin1、GND 

Pin2、VSS 5V電源 

Pin3、VOは液晶のコントラスト調整、電源入れる時一番弱くてGNDと接続する時は一番高い。 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  14 



    不可能への挑戦        株式会社日昇テクノロジー      低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

Pin4、RSはResister Select、Highレベルの時はデータレジスト、Lowレベル時は指令レジ

ストを選択する。 

Pin5、RWはRead/Write信号ライン、Highレベル時はRead操作、Lowレベル時はWrite操作。 

Pin6、EはEnable信号、HighからLowに変換する時、液晶モジュールがコマンドを実行する。 

Pin7～14、D0～D7、8bit双方向データライン。 

1602液晶モジュール内部のCGROMに160個のドットマトリックスの文字やグラフィックを保

存している。 

 

コマンド表： 
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もっと詳しい内容は下記資料をご参照ください： 

http://www.dragonwake.com/download/LCD/hd44780u.pdf  
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2.10 USBインタフェース 

Cypress 社の CY68013 マイコンを採用している。 

回路図： 

 

データ信号： 

CY7C18013 Pin Signal  FPGA Pin 

PB/FD0   USB_D0   Pin 116 

PB/FD1   USB_D1   Pin 115 

PB/FD2   USB_D2   Pin 114 

PB/FD3   USB_D3   Pin 113 

PB/FD4   USB_D4   Pin 101 

PB/FD5   USB_D5   Pin 100 

PB/FD6   USB_D6   Pin 97 
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PB/FD7    USB_D7   Pin 96 

PB/FD8    USB_D8   Pin 65 

PB/FD9    USB_D9   Pin 64 

PB/FD10   USB_D10  Pin 63 

PB/FD11   USB_D11  Pin 62 

PB/FD12   USB_D12  Pin 61 

PB/FD13   USB_D13  Pin 120 

PB/FD14   USB_D14  Pin 119 

PB/FD15   USB_D15  Pin 117 

コントロール信号： 

CY7C18013 Pin  Signal  FPGA Pin 

RDY0/SLRD   USB_SLRD  Pin 86 

RDY1/SLWR   USB_SLWR  Pin 85 

CTL0/FLAGA(pf半分)  USB_FLAGA  Pin 95 

CTL1/FLAGB(full)  USB_FLAGB  Pin 94 

CTL2/FLAGC(empty)  USB_FLAGC  Pin 78 

PA7/FLAGD   USB_FLAGD  Pin 67 

PA2/SLOE   USB_SLOE  Pin 74 

PA6/PKTEND   USB_PKTEND  Pin 68 

PA4/FIFOADR0   USB_FADDR0  Pin 72 

PA5/FIFOADR1   USB_FADDR1  Pin 71 

CLKOUT    USB_CLK  Pin 184 

IFCLK    USB_IFCLK  Pin 80 

もっと詳しい内容はUSBのデータシートをご参照ください。 

 

2.11 高速非同期SRAM 

ISSI社の高速非同期SRAMを採用している。容量は256K×16Bit。Enable信号はByte毎に独立

なので、Byte毎に操作できる。 

回路図： 
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アドレス信号： 

SRAM Pin  FPGA Pin  External Bus Signal 

A0    Pin 190    SA1 

A1    Pin 189    SA2 

A2    Pin 187    SA3 

A3    Pin 185    SA4 

A4    Pin 183    SA5 

A5    Pin 182    SA6 

A6    Pin 181    SA7 

A7    Pin 180    SA8 

A8    Pin 178    SA9 

A9    Pin 176    SA10 

A10    Pin 175    SA11 

A11    Pin 172    SA12 

A12    Pin 171    SA13 

A13    Pin 169    SA14 

A14    Pin 168    SA15 

A15    Pin 167    SA16 
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A16    Pin 166    SA17 

A17    Pin 165    SA18 

データ信号 

SRAM Pin  FPGA Pin  External Bus Signal 

sram_db[0]   Pin 102    SD0 

sram_db[1]   Pin 106    SD1 

sram_db[2]   Pin 107    SD2 

sram_db[3]   Pin 108    SD3 

sram_db[4]   Pin 109    SD4 

sram_db[5]   Pin 111    SD5 

sram_db[6]   Pin 122    SD6 

sram_db[7]   Pin 123    SD7 

sram_db[8]   Pin 124    SD8 

sram_db[9]   Pin 125    SD9 

sram_db[10]   Pin 126    SD10 

sram_db[11]   Pin 128    SD11 

sram_db[12]   Pin 130    SD12 

sram_db[13]   Pin 131    SD13 

sram_db[14]   Pin 132    SD14 

sram_db[15]   Pin 133    SD15 

コントロール信号 

SRAM Pin  FPGA Pin  External Bus Signal 

CE#    SRAM_ CE#    Pin 140 

OE#    SRAM_ OE#    Pin 139 

WE#    SRAM_ WE#    Pin 141 

BE0    SRAM_ BE0    Pin 137 

BE1    SRAM_ BE1    Pin 138 

 

2.12 高速同期SDRAM 

回路図： 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  20 



    不可能への挑戦        株式会社日昇テクノロジー      低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

アドレス信号： 

SDRAM Pin  FPGA Pin  External Bus Signal 

A0    Pin 191    SA0 

A1    Pin 190    SA1 

A2    Pin 189    SA2 

A3    Pin 187    SA3 

A4    Pin 185    SA4 

A5    Pin 183    SA5 

A6    Pin 182    SA6 

A7    Pin 181    SA7 

A8    Pin 180    SA8 

A9    Pin 178    SA9 

A10    Pin 176    SA10 

A11    Pin 175    SA11 

BA0    Pin 172    SA12 

BA1    Pin 171    SA13 

データ信号 
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SDRAM Pin  FPGA Pin  External Bus Signal 

DQ0    Pin 102    SD0 

DQ1    Pin 106    SD1 

DQ2    Pin 107    SD2 

DQ3    Pin 108    SD3 

DQ4    Pin 109    SD4 

DQ5    Pin 111    SD5 

DQ6    Pin 122    SD6 

DQ7    Pin 123    SD7 

DQ8    Pin 124    SD8 

DQ9    Pin 125    SD9 

DQ10    Pin 126    SD10 

DQ11    Pin 128    SD11 

DQ12    Pin 130    SD12 

DQ13    Pin 131    SD13 

DQ14    Pin 132    SD14 

DQ15    Pin 133    SD15 

コントロール信号 

Signal  FPGA Pin 

SD_CAS   Pin 148 

SD_CKE   Pin 156 

SD_RAS   Pin 149 

SD_WE   Pin 146 

SD_LDQM  Pin 143 

SD_USB_DQM  Pin 144 

SDCLK   Pin 147 

2.13 大容量、快速Flash 

回路図： 
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アドレス信号： 

Flash Pin  FPGA Pin  External Bus Signal 

A0    Pin 190    SA1 

A1    Pin 189    SA2 

A2    Pin 187    SA3 

A3    Pin 185    SA4 

A4    Pin 183    SA5 

A5    Pin 182    SA6 

A6    Pin 181    SA7 

A7    Pin 180    SA8 

A8    Pin 178    SA9 

A9    Pin 176    SA10 

A10    Pin 175    SA11 

A11    Pin 172    SA12 

A12    Pin 171    SA13 

A13    Pin 169    SA14 

A14    Pin 168    SA15 
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A15    Pin 167    SA16 

A16    Pin 166    SA17 

A17    Pin 165    SA18 

A18    Pin 162    SA19 

A19    Pin 161    SA20 

データ信号 

Flash Pin  FPGA Pin  External Bus Signal 

DQ0    Pin 102    SD0 

DQ1    Pin 106    SD1 

DQ2    Pin 107    SD2 

DQ3    Pin 108    SD3 

DQ4    Pin 109    SD4 

DQ5    Pin 111    SD5 

DQ6    Pin 122    SD6 

DQ7    Pin 123    SD7 

DQ15/A-1   Pin 191    SA0 

コントロール信号 

Flash Pin FPGA Pin 

FLASH_CE  Pin 155 

FLASH_OE  Pin 154 

FLASH_RW  Pin 150 

FLASH_RY_BY  Pin 135 

 

2.14 拡張アドレスバス 

回路図： 
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ピンマップ： 

External Bus Signal FPGA Pin  External Bus Signal FPGA Pin 

SA0    Pin 191    SA10    Pin 176 

SA1    Pin 190    SA11    Pin 175 

SA2    Pin 189    SA12    Pin 172 

SA3    Pin 187    SA13    Pin 171 

SA4    Pin 185    SA14    Pin 169 

SA5    Pin 183    SA15    Pin 168 

SA6    Pin 182    SA16    Pin 167 

SA7    Pin 181    SA17    Pin 166 

SA8    Pin 180    SA18    Pin 165 

SA9    Pin 178    SA19    Pin 162 

SA20    Pin 161    SYS_RESET   Pin 152 

FLASH_RW   Pin 150    SRAM_CE#   Pin 140 

FLASH_CE   Pin 155    SRAM_WE#   Pin 141 

FLASH_OE   Pin 154    SRAM_OE#   Pin 139 

 

2.15 拡張データバス 

回路図： 
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ピンマップ： 

External Bus Signal FPGA Pin  External Bus Signal FPGA Pin 

SD0    Pin 102   SD8    Pin 124 

SD1    Pin 106   SD9    Pin 125 

SD2    Pin 107   SD10    Pin 126 

SD3    Pin 108   SD11    Pin 128 

SD4    Pin 109   SD12    Pin 130 

SD5    Pin 111   SD13    Pin 131 

SD6    Pin 122   SD14    Pin 132 

SD7    Pin 123   SD15    Pin 133 

USB_D0    Pin 116   USB_D8    Pin 65 

USB_D1    Pin 115   USB_D9    Pin 64 

USB_D2    Pin 114   USB_D10   Pin 63 

USB_D3    Pin 113   USB_D11   Pin 62 

USB_D4    Pin 101   USB_D12   Pin 61 

USB_D5    Pin 100   USB_D13   Pin 120 

USB_D6    Pin 97    USB_D14   Pin 119 

USB_D7    Pin 96    USB_D15   Pin 117 
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2.16 拡張ユーザIO 

回路図： 

 

ピンマップ： 

External Bus Signal FPGA Pin  External Bus Signal FPGA Pin 

CLK_IN    Pin 79    CLK_OUT   Pin 81 

LCD0    Pin 22    LCD4    Pin 28 

LCD1    Pin 24    LCD5    Pin 29 

LCD2    Pin 26    LCD6    Pin 31 

LCD3    Pin 27    LCD7    Pin 33 

GPIO0    Pin 35    GPIO1    Pin 34 

GPIO2    Pin 37    GPIO3    Pin 36 

GPIO4    Pin 40    GPIO5    Pin 39 

GPIO6    Pin 43    GPIO7    Pin 42 

GPIO8    Pin 45    GPIO9    Pin 44 

GPIO10    Pin 46    GPIO11    Pin 77 

SW0    Pin 58    SW1    Pin 47 

SW2    Pin 52    SW3    Pin 51 
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2.17 JTAGインタフェース 

JTAG インタフェースを通じて FPGA ダウンロードする。ChipSCOP もサポートする。デバッ

グ段階では JTAG モードを利用する。 

回路図： 

 

XCF02S を利用する場合は PROM モードでダウンロードする。 
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2.18 電源回路 

 

 

2.19 リセット回路 

回路図： 

 

ピンマップ： 

Device  Signal  FPGA Pin 

UR1-7   SYS_RESET  Pin 152 

 

2.20 クロック 

回路図： 
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ピンマップ： 

Clock   Signal  FPGA Pin 

50.000MHz  MCLKIN  Pin 76 

ユーザオプション GPIO11   Pin 77 

説明： 

FPGA 内部は DLL があって、50MHz のクロックをニーズに応じて必要なクロックを分頻でき

る。特殊なクロックは 50MHz で生成できない場合はユーザオプションを利用ください。 
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第三章 初体験 

Examples\s2_fre を例として操作手順を説明します。 

3.1 プロジェクトの起動 

既存プロジェクトを起動する場合は File→Open Project で開く。或いは.ise ファイルをダ

ブルクリックで開く。 

 

 

3.2 ボードに書き込み 

2 種類の方法があります：JTAG モードと PROM モード。JTAG モードでダウンロードする場合

は電源切ると情報が保存されない。PROM モードの場合はメモリに書き込まれて、電源入れ

ると自動的にロードして実行する。 

 

3.2.1 JTAGモードでダウンロード 

Processes 欄の Generate Programming File をダブルクリックすると JTAG モードでダウン

ロードする用の bit ファイルが生成される。 
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Configure Target Device をダブルクリックする。 

 

OK を押す。或いは Configure Target Device 下にある Manage Configuration Project 

(iMPACT)をダブルクリックする。 
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JTAG モードを選択して、“Automatically connect to a cable and identify Boundary-Scan 

chain”のデフォルトの設定で Finish を押す。 
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Bypass を押す。 

 
Open を押す。 
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デフォルトの設定で OK を押す。 

 

FPGA を選択して右クリックする。 
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OK を押す。 

ダウンロード完了後の画面： 

 

 

3.2.2 PROMモードで書き込む 

Processes 欄の Generate Target PROM/ACE File をダブルクリックする。 
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Next を押す。 

 

File Name を入力する。その他はデフォルトで Next を押す。 
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Next を押す。 

 

Xcf02s を選択して Add を押す。Next を押す。 
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Finish を押す。 

 

OK を押す。 
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FPGA Bit ファイルを選択して“開く”を押す。 

 

No を押す。 

 

OK を押す。 
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Processes 中の Generate File...をダブルクリックする。 

 

これで PROM モードで書き込み用の.mcs ファイルが生成される。 

 

Boundary Scan をクリックする。 

右側の空白欄で右クリックして“Initialize Chain”をクリックする。 
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先ほど生成したファイルを指定して Open を押す。 

 
Bypass を押す。 
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OK を押す。 

 

Xcf02s を右クリックして Program を押す。 
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再度電源を入れると書き込んだファイルが実行される。 
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第四章 開発基本手順 

Examples\s1_led\sw_led を例として開発基本手順を紹介します。 

実現機能：ボード上のキーで LED を下記ロジックで制御する。 

 

 

4.1 Project Navigatorの起動 

Xilinx ISE 10.1i バージョンを基に説明します。 

スタート→すべてのプログラム→Xilinx ISE 10.1i→Project Navigator をクリックする。 
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4.2 プロジェクトの新規作成 

新規作成する場合の手順は下記通り： 

1、File→New Project 
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2、Project Name 欄に名称を入力する。Project Location 欄に保存場所を選択する。 

Top-Level Module Type は主に二種類を使います。 

HDL(Hardware Design Language)ハードウェア設計言語モードと Schematic 原理図モード。

この試験では HDL を選択する。Next を押す。 

 

本試験は合成ツールとシミュレーションツールは全部 ISE を利用します。デフォルトのま

ま Next を押す。 

３、ソースを作成する。 
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後で作成してもいいので、ここはこのまま Next を押す。 

４、既存ソースの追加。 

 

後で作成してもいいので、ここはこのまま Next を押す。 

５、新規作成するプロジェクトの詳細情報を確認して、問題なければ Finish を押して、

sw_led と言う名称のプロジェクトが作成される。 
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4.3 新規作成プロジェクトにソースファイルの追加 

1、既存ソースファイルの追加 

xc3s400-4pq208 を選択して、Project→Add Source をクリックして、既存の.v .vhd ファイ

ルを追加する。 
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2、ソースファイルの新規作成 

xc3s400-4pq208 を選択して、Project→New Source をクリックして、下記画面が出る。 

 

左側から作成するソースファイルの種類を選択して、File name と Location を入力する。 

Add to project を選択する事でプロジェクトに追加される。Next を押す。 
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この画面で新規作成するソースファイルの入力、出力ポートを追加してもいいですが、直

接 Next を押して、ソースファイルを編集する時追加してもいいです。 

 

新規作成するソースファイルの詳細情報を確認して、問題なければ Finish を押して、sw_led

と言う名称のソースファイルのフレームが作成される。 
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ソースを編集する。 

module sw_led(clk, rst, sw0, sw1, sw2, sw3, led0, led1, led2, led3, led4, 

led5, led6, led7); 

input clk; 

input rst; 

input sw0; 

input sw1; 

input sw2; 

input sw3; 

output led0; 

output led1; 

output led2; 

output led3; 

output led4; 

output led5; 

output led6; 

output led7; 

wire led0; 

wire led1; 

wire led2; 

wire led3; 
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wire led4; 

wire led5; 

wire led6; 

wire led7; 

wire [3 :0] sw; 

reg [7 :0] led; 

assign sw = {sw0,sw1,sw2,sw3}; 

assign {led0,led1,led2,led3,led4,led5,led6,led7} = led; 

always @ ( posedge clk or negedge rst) 

begin 

if(!rst) 

led<='b0; 

else 

case ( sw ) 

4'b0001: led <= 8'b0000_0001; 

4'b0010: led <= 8'b0000_0010; 

4'b0100: led <= 8'b0000_0100; 

4'b1000: led <= 8'b0000_1000; 

4'b0011: led <= 8'b0001_0000; 

4'b0110: led <= 8'b0010_0000; 

4'b1100: led <= 8'b0100_0000; 

4'b1001: led <= 8'b1000_0000; 

default: led <= 8'b0000_0000; 

endcase 

end 

endmodule 

保存する。 

 

4.4 合成及びシミュレーション 

4.4.1 合成 

Processes 欄の Synthesize-XST をダブルクリックする。 

主にはソースプログラムの構文エラーを検査する。 
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View Synthesis Reportをダブルクリックして結果を見える。 

 

ここでエラー発生した場合は Error ポップが表示される。提示内容によって修正して再度
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合成すればいいです。 

4.4.2 シミュレーション 

１、シミュレーションファイルの作成 

Project→New Source をクリックして、Test Bench Wavefrom ファイルを生成する。 

 

左側から作成するソースファイルの種類を選択して、File name と Location を入力する。 

Add to project を選択する事でプロジェクトに追加される。Next を押す。 
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対象ファイル sw_led を選択して、Next を押す。 

 

作成される同時に下記画面が表示され、タイミングについてのパラメ

ータを設定する。 

情報を確認して Finish を押す。 

test.tbw ファイルが

 

シミュレーションの必要に応じて設定して Finish を押す。新規作成した波形ファイルが表
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示される。 

 

２、パラメータの修正 

タイミングパラメータは前のステップで設定しましたが、修正したい場合は下記方法があ

メニューの Test Bench → Rescale Timing… 

ります。 
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修正して OK を押す。 

或いは Test Bench → Set End of Test Bench… 

 

終了タイミングを設定できます。 

 

OK を押すと、End Time が 1000ns から 2000ns に変更される。 
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波形図の青色のバーをクリックすると High、Low のレベルを設定できる。 

 

３、シミュレーション 

test.tbw を選択して、Process View から View Generated Test Bench As HDL をダブルク

リックする。 
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Simulate Behavioral Model をダブルクリックしてシミュレーションの結果を見る。 
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4.5 Constraintsの編集 

 

Timing Constrains、IO-Pre-Synthesis、Area/IO/Logic-Post-Synthesisがある。 

本試験ではIO-Pre-Synthesisだけ利用する。 

Process viewからIO-Pre-Synthesisをダブルクリックする。 

 
Loc 欄を pxxx のフォーマットで入力して保存する。 
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XST Optional を選択して OK。Xilinu PACE ウィンドウを閉じる。 

 

4.6 実行 

Processes view の Implement Design をダブルクリックする。 

 

完了後緑色のチックが表示したら成功。 

 

4.7 ボードにダウンロードして実行 

「3.2 ボードに書き込み」節をご参照ください。 

 

 

以上。 
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